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1 Introduction to ImTOO MPEG Encoder 

1.1 Welcome 

 

Welcome to ImTOO MPEG Encoder！Thank you for purchasing this product. It is powerful 
audio/video conversion software that supports conversion of most popular audio/video formats. 
For example, you can easily convert WMV into AVI or MPEG format with it. It also supports the 
conversion of the latest H.264 video file and to output MP4 formats for iPod and PSP etc.. 

What’s more, ImTOO MPEG Encoder supports to adjust parameters of audio/video codec and the 
ID3 editing function of audio formats such as WMA and MP3. With it, you can also extract and 
convert the audio from a video file, to recopy a music CD. 

In addition, ImTOO MPEG Encoder provides the wizard mode, which helps you complete the 
conversion Step by Step. 

We sincerely hope ImTOO MPEG Encoder could solve the actual problems in your daily life and 
work and bring you a more convenient audio visual entertainment.  
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1.2 Supported Formats 

Supported input formats 

3GPP Files (*.3gp) 

3GPP2 Files (*.3g2) 

Animated GIF Files (*.gif) 

AVI Files (*.avi) 

DV Video Files (*.dv;*.dif) 

QuickTime Files (*.mov;*.qt) 

Macromedia Flash Files (*.swf) 

MJPEG Video Files (*.mjpg;*.mjpeg) 

MP2 Files (*.mp2) 

Mp3 Files (*.mp3) 

Ogg Vorbis Files (*.ogg) 

AAC Files (*.aac) 

MPEG-4 Audio Files (*.m4a;*.mp4) 

MPEG-4 Files (*.mp4) 

NUT Files (*.nut) 

Raw AC3 Files (*.ac3) 

Raw h261 Files (*.h261) 

Raw h264 Video Files (*.h261;*.h264) 

Raw MPEG4 Video Files (*.m4v) 

Raw Video Files (*.yuv) 

Real Media Files (*.rm;*.ra;*.ram;*.rmvb) 

Windows Media Files (*.wma;*.wmv;*.asf) 

MPEG Files (*.mpg;*.mpeg;*.mpa;*.dat;*.vob) 

Monkey's Audio Files (*.ape;*.cue) 

WAV Files (*.wav;*.au;*.aiff) 

CD Audio (*.cda) 
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Supported output formats 

MP4 - MPEG-4 Video (*.mp4) 

3GPP - 3rd Generation Partnership Project (*.3gp) 

3GPP2 - 3rd Generation Partnership Project 2 (*.3g2) 

AAC - Advanced Audio Coding (*.aac) 

AC3 - Dolby Digital AC-3 (*.ac3) 

Apple TV h264 (320*240) (*.mp4) 

Apple TV h264 480P (640*480) (*.mp4) 

Apple TV h264 720P (1280*720) (*.mp4) 

Apple TV MPEG-4 high 480P (640*480) (*.mp4) 

Apple TV MPEG-4 Low 480P (640*480) (*.mp4) 

Apple TV MPEG-4 Normal 480P (640*480) (*.mp4) 

ASF - Advanced Streaming Format (*.asf) 

SUN AU Format (*.au) 

AVI - Audio-Video Interleaved (*.avi) 

DivX Movie (*.avi) 

DVD (*.vob) 

FLV - Flash Video Format (*.flv) 

iPod (320*240)MPEG-4 Normal (*.mp4) 

iPod Video2(640*480) MPEG-4 Normal (*.mp4) 

M4A - MPEG-4 Audio (*.m4a) 

MOV - QuickTime (*.mov) 

MP2 - MPEG Layer-2 Audio (*.mp2) 

MP3 - MPEG Layer-3 Audio (*.mp3) 

Zune MPEG-4 Video (*.mp4) 

MPEG-1 Movie (*.mpg) 

MPEG-2 Movie (*.mpg) 

MPEG- 4 AVC Video Format (*.mp4) 

Zune MPEG-4 AVC Video Format (*.mp4) 

OGG - Ogg Vorbis Audio (*.ogg) 

 



 

PS3 Video (1080P) MPEG-4(*.mp4) 

PS3 Video (720P) MPEG-4 (*.mp4) 

PS3 Video (480P) MPEG-4 Excellent (*.mp4) 

PS3 Video (480P) MPEG-4 (*.mp4) 

PSP - PSP MPEG-4 Video (*.mp4) 

PSP AVC Video Format (*.mp4) 

PSP AVC Video (480x272) (*.mp4) 

RA - RealAudio (*.ra) 

RM - RealVideo (*.rm) 

Super VideoCD (*.mpg) 

SWF - SWF Format (*.swf) 

Video CD (*.mpg) 

VOB - MPEG2 PS Format (*.vob) 

WAV - Waveform Audio (*.wav) 

WMA - Windows Media Audio (*.wma) 

WMV - Windows Media Video (*.wmv) 

Zune WMV - Windows Media Video (*.wmv) 

XviD Movie (*.avi) 

1.3 Features 

 Convert one video format into another; 

 Extract and convert the audio file from a video one; 

 Support the recopy of a music CD; 

 Support the conversion of audio/video clips with customized starting point and length; 

 Support to adjust parameters of audio/video codecs; 

 Support to edit the ID3 tag; 

 Support to play back audio/video files; 

 Support to view the source file information; 

 Support to set different zooming modes for the output file; 

 Support to set different splitting modes for the output file; 
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 Support to set the name of the output file; 

 Support to remove the copy protection; 

 Support multi-threading and batch conversion; 

 Support multiple languages such as simplified Chinese and English, etc.; 

 Support H.264/PSP AVC and H.264/MPEG-4 AVC codecs; 

 Support wizard mode. 
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2 Installing of ImTOO MPEG Encoder 

2.1 System requirements 

 OS Supported － Windows 98/ME/NT4/2000/2003/XP and Windows Vista 

 Processor － 750MHz Intel, AMD CPU, or above 

 Free Hard Disk Space － 100MB or more 
 

2.2 Installation 

Step 1: Download the installation package for ImTOO MPEG Encoder from http://www.imtoo.com. 

Step 2: Double-click "mpeg-encoder.exe" to start installation. 

Step 3: Follow the instructions to finish the installation. 

2.3 Uninstall 

Method 1: 

ImTOO MPEG Encoder provides the uninstall function. By using it, you can easily delete all the 
files, program groups or shortcuts created by the software. 

To do this, click “Start > Programs > ImTOO > MPEG Encoder” in turn, and then click the 
“Uninstall” option. 

Follow the instructions to finish uninstall. 

Method 2: 

Of course, you can also click the “Add > Remove Programs“ in the Control Panel of your Windows 
system, select “ImTOO MPEG Encoder” in the “Add/Remove Programs” window and then click the 
“Delete“ button to completely uninstall the software. 
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3 Getting Started 

3.1 Starting the application 

After installation, you can start the application by one of the following methods: 

Method 1: 

Select “MPEG Encoder” program group in “Start > Programs > ImTOO” and then select “ImTOO 
MPEG Encoder” to start the application. 

Method 2: 

After the installation, an icon with the name of ImTOO MPEG Encoder will be automatically 
created on your desktop. Double-click the icon to run the application. 

After ImTOO MPEG Encoder starts, the main window will pop up, as indicated below: 

 

In addition, you can also start the wizard mode of ImTOO MPEG Encoder, so that you can finish 
the conversion according to its procedures in an easier and simpler way. 
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For more information about "ImTOO MPEG Encoder Wizard" Mode, please refer to the Chapter 
"Using Wizard Mode”. 

 

3.2 Quick start 

Step 1: Add audio/video files 

In the main interface, click the  button to add the audio or video files that you wish to 
convert to the video list.   
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Tip: All files to be added into the video list will be checked as default. 

In addition, by “File > Add…” / “File > Add DirectShow Files…” option, or “Add…” / “Add 
DirectShow Files…” option in the right-click menu of video list, you are also able to add files. 

 

 

 

 ImTOO Software Studio, 2007 Page 9 
 



 

Step 2: Preview file to be converted  

After the file is added, by the Preview Player at the right-bottom of main interface you can preview 

the selected file. Select the file to be previewed and click the  button in the player to start 

the preview. 

 

During the playback, by "Previous", "Pause", "Stop", "Next" button you can adjust the playing 
position. 

Tip: This function is only used for the preview, which does not represent the final conversion 
results. 

For more information about "Preview", please refer to the Chapter "Preview Player" in the 
"Operation Instructions". 

 

Step 3: Set the profile 

After checking the files you wish to convert, you need to set the profile, i.e. the format of the output 
file.  

To do this: 

In the video list, select the file that you wish to convert, and then select the required profile in 
“Profile” drop list on the main interface. 
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After selection, the selected format will be shown in the "Target" column in the video list. 

 

By repeating the previous operation, you can set different profiles for different files. 

Tip: The software supports the decoding and encoding of multiple audio and video formats，and 
conversion of formats such as Apple TV, iPod, PSP, MP4, 3GP etc..  

Moreover, it supports multi-threading technology and batch conversion. After the "Profile” of all 
files is set, the software will automatically complete the conversion in turn. 

 



 

For more information about "profile", please refer to the chapter "Supported profiles" in "Set 
profile". 

 

Step 4: Adjust profile properties 

After selecting the profile for the files, main parameters of this "profile" will be shown on the output 
property list on right main interface. 

 

 

You can adjust parameters to meet your requirements; of course, you can also keep the defaults. 

Tip: The software supports conversion of video clips. This could be realized by setting the start 
time and duration length in the output property list. 

For example, if you want to convert the clip from 00:00:20 to 00:00:50, please set the duration as 
“30s” and the start time as “00:00:20”. 

For more information about "Output property list", please refer to the chapter "Common Output 
property list" in "Set Profile". 

 

Step 5: Set the destination 

Set the path to save the output files.  

To do this, enter the path directly into the “Destination” edit box, or click “Browse” button and select 
the required folder in the dialogue box that appears. 
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In addition, you can also set different zooming mode and splitting mode for the output files on the 
output control panel.  

 

 

Step 6: Start the conversion 

Click the  button on the main interface to start the conversion of the files checked in the 
video list. 

Tip: If the file is added into the video list, it will be checked as default. You can uncheck it 
according to your own requirements. 

During the conversion, you can monitor the conversion progress which will be shown in the Status 
column in the video list. 
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Moreover, during the conversion, you can also click the “Pause” button on the main interface to 
pause the conversion, or the “Stop” button to stop the conversion. 

 

Step 7: Finish conversion 

After the conversion is done, click the  button at the bottom of the main interface to 

open the “Output Folder” and view the conversion results. 

Tip: 

1. The software has a built-in "PSP Video Manager" function. After the conversion, you can easily 
import PSP video files into PSP devices. 

For more information about "PSP Video Manager", please refer to the chapter "Main Menu>Tools 
Menu” in "Operation instructions". 

2. If the output file is in iPod MP4 format, you only need to click the  button and, in 

the Destination, copy or drag the required files into your iTunes. 
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3.3 How to view the conversion result 

Step 1: Run the software, add and check the files you wish to convert, select required profiles, and 

then click the  button to start the conversion. 

 



 

 

Step 2: After the conversion is finished, you can click the  button to browse output 

files in the file folder that appears. 

 

Tip: During the conversion, you can also click the  button to view the conversion 

result. 
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3.4 How to adjust the parameters of the selected profile 

Step 1: Run the software, add and select the files you wish to convert, and then select profile. 

 

Step 2: After selecting profile, the parameters of it will be shown in the output property list on the 
right main interface. If you want, you can adjust some parameters in this list. 

For video parameters, video codec, video bit rate, video size and frame rate etc. can be set; for 
audio parameters, audio codec, audio bit rate, sample rate and channels etc. can be set. If it is 
necessary to convert only clips of the selected file, please set the relevant two parameters, 
"Duration" and "Start Time". In addition, if the profile is WMV, WMA or MP3, you can also edit ID3 
Tag of the output file. 

For example, in “Video-Bit Rate” drop list, select your required bit rate. 
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Tip: 

1. For different profiles, modifiable parameters are different too. 

2. To adjust the parameters, you can select only one file at a time. Of course, you can also select 
more files. In this case, the modifiable parameters will be the common modifiable ones for all the 
selected files. 

For more information about "Output property list", please refer to the chapter "Common Output 
property list" in "Set Profile". 

 

3.5 How to customize profile  

Besides the profiles provided by the software, you can also customize your own profile according 
to your needs. In addition, you can save, rename and delete the customized "profile". 

To do this: 

Step 1: Run the software, add and select the files you wish to convert, select profile and then 
modify the parameters in the output property list. 

Step 2: After the modification, you can save the modified profile in a customized way. Click the 

 button on the right of the “Profile” drop list. In the dialogue box that appears, enter a 

name for the customized profile, and click "OK" to save it. Then, the customized profile will be 
added to the "Profile" drop list for your future use. 
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Moreover, for the customized profile, you can rename or delete it by clicking the  button.  
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4 Operating Instructions 

4.1 Interface layout 

 

 
1 Main menu Provide menu items such as File, Edit, View, Tools and Help. 
2 Button bar This area provides "Add", "Remove", "Clear", "Encode", "Pause" 

and "Stop" buttons. 
3 Video list Display the information about the added files and the conversion 

status. 
4 Output control panel In this area, you can set the profile, the zooming mode, the splitting 

mode and the destination of output files. 
5 Status bar  Display the information about the files and the progress of the 

conversion, and offer log view. 
6 Output property list In this area, you can adjust the general properties, the audio 

parameters, the video parameters and the ID3 tag of the selected 
profile. 

7 Preview player  Playback the selected file. 
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4.2 Main menu 

4.2.1 File menu 

 

Add…  

Click to select the files you wish to convert in the pop-up dialogue box. After adding, all the added 
files will be displayed in the video list. 

Add DirectShow files… 

Click to add the files you wish to convert to the video list. During the conversion, DirectShow 
technology will be adopted for the decoding and encoding. 

For more information about "DirectShow", please refer to the chapter "Add DirectShow File" in 
"Advanced Operation". 

Remove 

Click to remove the selected files from the video list. 

Clear 

Click to clear all the files from the video list. 

Encode 

Click to start the conversion of all checked files from the video list. 

Stop 

Click to stop the conversion of all checked files in the video list during encoding. 
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Pause 

Click pause option to convert all checked files in the video list during encoding. 

Encode Selected Item(s) 

Click to start the conversion of all selected checked files in the video list. 

Stop Selected Item(s) 

Click to stop the conversion of all selected checked files in the video list during encoding. 

Pause Selected Item(s) 

Click pause item to convert of all selected checked files in the video list during encoding. 

Exit 

Exit the application. 

 

4.2.2 Edit menu 

 

Check All 

Click to check all files in the video list. 

Uncheck All 

Click to uncheck all files in the video list. 

Check Selected 

Click to check the selected files in the video list. 

Uncheck Selected 

Click to uncheck selected files in the video list. 
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4.2.3 View menu 

 

Change Skin… 

Open the “Change Skin” dialogue box to select the required software skin. 

Language 

Click “Language” option to select the required software language from its submenu. 

Show File Information 

Click this option to open “File Information” dialogue box for viewing the detailed information of the 
selected file. 

 

4.2.4 Tools menu 

 

PSP Video Manager 

Titled PSP Video Manager, by which you can import the video files that have been converted to the 
PSP format to PSP devices. 
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Preferences 

Open the Preferences tab, where you can modify the preferences for application. 

For more information about "Preferences", please refer to the chapter "Preferences tab" in 
"Operation Instructions". 

 

4.2.5 Help menu 

 

Contents 

Click to open the help file.  

Buy Registration Code 

Click to open the web page where you can buy a registration code for this software. 

Enter Registration Code… 

Click to open the registration dialogue box, where you can enter the registration code for 
registration. 
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Feedback and Support 

Click to log onto the website of ImTOO Support Center. 

About… 

Click to open the “About” dialogue box; you can view the information about copyright, the version 
number and the registration of the software there.  

 

4.3 Preferences tab 

On the “Tools” menu, click “Preferences“ to open the Preferences tab. 

 

 

4.3.1 General tab 

Process 

You can set the maximum simultaneous processes and maximum simultaneous running 
processes that the software will do in conversion. 

Maximum simultaneous running processes, i.e. maximum number of files "under conversion" that 
the software allows. 

Maximum simultaneous processes, i.e. maximum number of files "under conversion" and 
"conversion paused" that the software allows. 

For more information about "Progress", please refer to ”FAQ>How to set simultaneous conversion 
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process" in “Technical Support”. 

Output file overwrite 

You can set the way of saving output files, i.e. the way of saving output files in case a file with the 
same name exists in the folder that saves output files. Two options are available. 

 

4.4 Button bar 

 

 Add button 

Add video/audio files you wish to convert into the video list. 

 Remove button 

Remove the selected files from the video list. 

 Clear button 

Clear all files from the video list.. 

 Encode button 

Click to start the conversion of all checked files in the video list. 

 Pause button 

Click pause button to convert all checked files. 

 Stop button 

Stop the conversion of all checked files. 
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4.5 Video list 

 

 
4.5.1 Header 

 
Checkbox 

Check the boxes to determine the files you wish to convert. 

Name 

Display the names of the added files. 

Duration 

Display the playback duration of the added files. 

Type 

Display the original formats of the added files. 

Target 

Display the output formats of the added files. 

Status 

Display the status information during conversion. 

The conversion status includes, Completed, Pause, Waiting, Waiting to continue, Abort, showing 
the percentage of the conversion job, blank (-) or Failed. 
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4.5.2 Right-click menu 

When running the software, you can also use the right-click menu to perform some basic actions.  

Right-click at any location of the video list to open the right-click menu. 

 

With the menu, you can easily carry out regular operations. 

Besides, when right-clicking a selected file, the "Show File Information" option becomes available. 
Click to open "File Information" box and view more information of the selected file. 
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4.6 Output control panel 

 

In the output control panel, you can set the output format, zooming mode, splitting mode and 
destination. Besides, you can manage the customized profiles and browse the output files after the 
conversion is done. 

Profile 

Set a profile for the file(s), i.e. the output format. 

Please select the profile in the "Profile" drop list. 

For more information about "profile", please refer to the chapter "Supported profiles" in "Set 
Profile". 

Save as 

Click to open a dialogue box where you can save your customized profiles. 

After selecting the customized profile in "Profile" drop list, switches to . 

Click the drop-down button at the right side of  button, to manage the customized 

profile you selected. 

 

Save: Save the re-customized profile for the one you selected. 

Save as: Save the customized or re-customized profile as a new profile. 

Rename: Rename the customized profile you selected. 

Delete: Delete the customized profile from the "Profile" list. 

Zoom 

 

Select different zooming modes for the output files. 

Letterbox: Keep the original picture and&or add black stripes to the original picture at its 

 



 

up/down or left/right sides to fit the output video size you set when needed. 

Medium: Synthesize “Letter box” and “Pan and Scan” to fit the output video size. 

Pan and Scan: Keep the aspect ratio of the original picture and enlarge the picture to fit the 
output video size you set when needed, and&or crop the picture to fit the output video size 
when needed. 

Full: Stretch or squeeze the picture to fit the output video size you set when needed. 

For more information about "Zoom", please refer to the chapter "Movie Zoom Rule" in 
"Advanced Operation". 

Split 

 

Select different splitting modes for the output files. 

Infinite: Output one file as per duration of the source file. 

650MB Recordable CD: Split the output file to several ones which maximum size should be 
650MB 

700MB Recordable CD: Split the output file to several ones which maximum size should be 
700MB 

800MB Recordable CD: Split the output file to several ones which maximum size should be 
800MB 

4.7GB Recordable CD: Split the output file to several ones which maximum size should be 
4.7GB 

Custom size: Split the output file as per the customized size, maximum size of a single output 
file is defined by the user. 

Custom time: Split the output file as per the customized duration, the maximum duration of a 
single output file is defined by the user 

Default: Infinite (No splitting) 

Destination 

Set the destination directory where the output files are saved. 
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4.7 Status bar 

 

During conversion, through the status bar, you can easily view the information about the file that is 
currently being converted. 

“frame” shows all the frames that have been converted to the output.  

“q” shows the quality of the current frame.  

“size” shows the current size of the output that has been done.  

“time” shows the duration of the source has been converted.  

“bit rate” shows the video bit rate of the current frame being converted. 

Besides, by clicking the  button at the right side of the Status Bar, you can open the “Log” 

dialogue box to view the conversion log.  
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4.8 Output property list 

 

After setting the profiles, you can further configure specific parameters for the selected file in the 
output property list that is on the right panel of the main interface. It includes general properties of 
audio and video formats, audio parameters, video parameters and&or ID3 tag parameters. 

For more information about "Output property list", please refer to the chapter "Common Output 
Property List" in "Set Profile". 

 

4.9 Preview player 

With the Preview Player, you can view the selected file. 

 

"Previous" button 

Jump to the previous file and start the playback. 

"Play" button 

Start to play back the selected file. 
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"Pause" button 

Click the “Pause” button to pause, and click it again to continue the playback. 

"Stop" button 

Stop the playback. 

"Next" button 

Jump to the next file and start to the playback 
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5 Using Wizard Mode 

The software supports a Wizard Mode. Compared with the standard mode, the wizard mode is 
more suitable for the primary users. The Wizard Mode will help you to finish one conversion job, 
and its operation is just easy and simple. 

The Wizard supports to convert multiple files at a time and to set the parameters of each file 
step-by-step. 

Compared with the standard mode, the following features are noticeable in the Wizard Mode: 

1) When setting the conversion time, dragging the slider to get the clip is in the Wizard Mode. In 
the preview window, by dragging the slider in the track bar, you could get the starting and ending 
points of the clip. Thus the users can get the accurate clip. In addition, you could input the time 
manually for the clip, which makes the settings more flexible and humane. 

2) Different from the "Standard Mode", Wizard Mode supports to set different destination path 
for saving different files in a batch conversion. 

 

5.1 Starting  

After the installation of the software, you can start up the Wizard Mode by either of following 
methods: 

Method 1: 

In “Start > Programs > ImTOO“, select “MPEG Encoder“ program group, click "ImTOO MPEG 
Encoder Wizard "option, and then start up the "Wizard Mode". 

Method 2: 

After the software is installed, the icon of “ImTOO MPEG Encoder Wizard” will be automatically 
created on your desktop. Then click it to start up the "Wizard Mode". 

A "Welcome" Window will pop up after the startup, where you can register your product or view 
your registration information. 
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5.2 Using  

5.2.1 Welcome 

 

Please click the  button to step into "Load Source File" window; click the 
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 button to terminate the wizard. 

In the navigation bar on the left, the current step will be highlighted as "Welcome". 

 

5.2.2 Load Source File 

 

Click the  button to select the file you wish to convert in a pop-up dialogue box.  

Besides, you can directly input a complete file path in the editing box. 
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Then, the audio/video parameters of the loaded file will be shown in the "Source Parameters" box. 

Please click the  button to step into the "Set Encoding Time" window. 

Tip: If the file loaded is not supported by the software, it will not step into the "Set Encoding Time" 
window.  
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5.2.3 Set Encoding Time 

 

Drag the slider on the track bar to get the starting and ending points of the clip you wish to convert. 

Drag it to the point, click the  button or the  button, then the 

Start Point or End Point on the right will be created automatically. 

 

Besides, you can directly input values in the time editing boxes to set the “Start Point”, “End Point” 

 



 

and the “Length” as well. 

Tip: The default "Start Point" is 00:00:00; “Length” is a complete duration of the source file. 

After these settings, the "Start Point", the "End Point" and the "Length" will be relevant. Please 

click the  button to step into the "Select Profile" window. 

 

Click the drop-down button of the "Profile" editing box to select the required "Profile". 

 

5.2.4 Select Profile 

 

Click the drop-down button of the "Profile" editing box to select the required "Profile". 
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In addition, by clicking the  button, you can adjust the specific parameters for 

the selected "Profile" as per your requirements in the list, such as the video size, the video bit rate, 
the audio bit rate, the channel, the sample rate etc.. 

Tip: As default, the "Output Property" list is in a hidden status. 

After those settings, please click the  button to step into the "Saving Your File" 

window.  
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5.2.5 Saving Your File 

  

Click the  button to select the destination of output file in the pop-up dialogue box. 

Moreover, you can also set the name of the output file. 

When done, click the  button to step into the "Job Summary" window. 
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5.2.6 Job Summary 

 

Check the settings and click the  button to step into the "Encoding" window to start 

the conversion process. 
What’s more, it supports more functions and general information of the settings. 
 
"Edit" button 
Re-edit the settings for the conversion. 
To do this: 
Select the file that you wish to re-edit in the video list and click "Edit" button to step back to the 
"Load Source File" window. 
 
"Add" Button 
Add more files. 
To do this: 
Click "Add" button, the wizard will step back to the "Load Source File" window. 
 
"Remove" Button 
Delete the selected file from the video list. 
 
"Clear" Button   
Clear all the files from the video list. 
 
When the required file is selected in the video list, the following items will be shown as: 
Source File 
Show the source file path of the selected file. 

 



 

Target File 
Show the destination of the selected file. 
 
Output Format 
Show the parameters of the output. 
 
Overwriting 
Set the way of covering output files, i.e. the way of covering output files in case a file with the same 
name exists in the folder that saves output files. 
 
Tip: 

Clicking the  button in the "Load Source File", "Set Encoding Time"，"Select Profile" 

and "Saving Your File" windows, it will directly step into the “Job Summary” window. 

In the "Job Summary" window, by clicking the  button, you will terminate the wizard, 

and the previous settings will not be saved. 
 

5.2.7 Encoding 
 

 
 
When the conversion is finished, you can see “Completed” in the "Status" column in the video list. 

You can view the conversion log. To do so, please click the   button to open "Log" 

box. By clicking the  button, you will step to the "Encoding Finish" window. 
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Tip: During the converting process, the "Encoding" window supports some other functions and 
general information of the conversion. 
 
"Pause" button 
Click to have pauses for the conversion being done, while "Pause" button will be changed to "Start" 
button. Click again to continue the conversion. 
"Stop" button 
Stop the conversion. 
Progress 
Show the conversion progress. 
Information 
Show the current data of the conversion 
 

5.2.8 Encoding Finish 

 

Click the  button to start a new conversion, or click the  button to 

terminate the wizard. 
Tip: The "Encoding Finish" window supports some other functions and general information. 
 
"Open Target Folder" Button 
Select the file in the video list; click the "Open Target Folder" button to open the target folder for 
viewing the output. 
Encoded job 
Show the source file path and target file path in bold if the conversion has been successful. 
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6 Advanced Operation 

6.1 Customizing Profile  

If you have modified parameters for a profile during conversion and you wish to continue to use 
them in the future, ImTOO MPEG Encoder allows saving the modified profile as a new profile. By 
doing this, you can use the new profile whenever you want. 

In addition, for the customized “Profile”, ImTOO MPEG Encoder provides operations such as 
“Save”, “Rename” and “Delete” etc.. 

 

6.2 Supporting H.264 

Ten profiles that support H.264 video codec are added to the profile list of ImTOO MPEG Encoder. 
They are PS3 Video(1080P) MPEG-4 (*.mp4), PS3 Video(480P) MPEG-4 (*.mp4), PS3 
Video(720P) MPEG-4 (*.mp4), PS3 Video (480P) MPEG-4 Excellent (*.mp4), PSP AVC Video 
Format (*.mp4), MPEG-4 AVC Video Format (*.mp4), Zune MPEG-4 AVC Video Format (*.mp4), 
Apple TV h264(320*240) (*.mp4), Apple TV h264 480P(640*480) (*.mp4) and Apple TV h264 
720P(1280*720) (*.mp4).. 

By using these profiles, the encoding data speed can be up to 30Mbit/s and the supported video 
size (pixel) is ranging from 96×80 to 1920×1072, which provides you with more and better choices. 

Tips:  

1. Until now H.264 video codec has only processed Macros of 16.Therefore, the width and height 
of a video should be multiples of 16. For example, if you wish to output a 1080i or 1080p HD video, 
please ensure that the video's height is 1072 or 1088 and the width is 1920. 

2. If you wish to select a profile which defines the 720p or above HD video, please ensure that the 
source file is of HD video. 

 

6.3 Apple TV profiles are supported  

The software provides six Apple TV profiles to support the conversion of Apple TV video to play 
back videos on an Apple TV connected with an iPod. 

The profiles are Apple TV h264(320*240) (*.mp4), Apple TV h264 480P(640*480) (*.mp4), Apple 
TV h264 720P(1280*720) (*.mp4), Apple TV MPEG-4 high 480P(640*480) (*.mp4), Apple TV 
MPEG-4 Low 480P(640*480) (*.mp4) and Apple TV MPEG-4 Normal 480P(640*480) (*.mp4), 
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6.4 Add DirectShow File 

For the conversion by ImTOO MPEG Encoder, the output audio/video files with some formats (for 
example, RM, RMVB, WMV, MKV) will fail to be converted or the outputs will be not in 
synchronization, which are not satisfactory 

In the case, we recommend that you can use “File > Add DirectShow File“ option in the main menu 
to load the files and try to convert them again.  

Tip:  

1. DirectShow is a COM–based multimedia development package, one kind of API (Application 
Programming Interface), launched by Microsoft. It supports the decoding and playback of local or 
network media files of various video, audio compressed formats; it not only can read multimedia 
streams from other devices, but also convert streaming media that have been processed by 
various compression algorithms. These formats include: audio and video encoded by MPEG 
codec, Audio-Video Interleaved (AVI), WAV, MIDI and advanced stream format-ASF. 

2. The software does not support to convert the files that are digitally copyright-protected. 

 

 ImTOO Software Studio, 2007 Page 45 

6.5 Movie Zoom Rule 

ImTOO MPEG Encoder supports to configure the zooming modes for the output files. To do this: 

Variance restraint: Rat1 is the aspect ratio of the source file 

                  Rat2 is the aspect ratio of the output file 

Letterbox 

Letterbox is a loss-less zooming method. It means that it will keep an intact video picture by the 
so-called “loss-less”. 

The editing rule is: 

When Rat1>Rat2, a black strip is added to fill in the up/down sides. 

The source file (Video size: 720×480)                  The output file (Video size:640×480) 
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When Rat1<Rat2, a black strip is added to fill in the left/right sides 

The source file (Video size: 720×480)             The output file (Video size: 1024×480) 

                 

Advantages: There will be no loss of the picture, and is commonly used.  

Disadvantages: The output file may become larger than the original one. 

 

Pan and Scan 

Pan and scan is a zooming method with picture losses. It means that it will lose certain video 
picture by the so-called “picture losses” 

The editing rule is: 

When Rat1>Rat2, the picture will be enlarged to a full screen, then part of the picture will be cut off 
on left/right sides. 

The source file (Video size: 720×480)            The output file (Video size: 640×480) 

                 

When Rat1<Rat2, the picture will be enlarged to a full screen, then part of the picture will be cut off 
on up/down sides. 

Source (Video size: 720×480)               Output file (Video size: 1024×480) 

             

Advantages: The movie can be displayed in a full screen, with a better quality of the visible 

 



 

picture.  

Disadvantages: The picture will be lost partially. 

 

Medium 

Medium synthesizes ‘Letter box’ and ‘Pan and Scan’ to fit the output video size, where partial 
picture is cut off with some black strips filled in, so that a balance can be kept between the picture 
quality and the picture loss (cutting the left/right and filling the up/down or vice versa) 

The editing rule is: 

When Rat1>Rat2, the picture will be cut off on the left/right sides of picture, and some black strips 
are filled on the up/down sides. 

The source file (Video size: 720×480)              The output file (Video size: 640×480) 

                  

When Rat1<Rat2, the picture will be cut off on the up/down sides of picture, and some black strips 
are filled on the left/right sides. 

The source file (Video size: 720×480)            The output file (Video size: 1024×480) 

                

Advantages: An efficient balance is kept between the picture quality and the picture loss, which is 
required by some customers. 

 

Full 

Full is to stretch or squeeze the picture to fit the output video size you set when needed 

The editing rule is: 

When Rat1>Rat2, the picture will be stretched on the up/down sides. 
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The source file (Video size: 720×480)                    The output file (Video size: 640×480) 

               

When Rat1<Rat2, the picture will be stretched on the left/right sides 

The source (Video size: 720×480)              The output file (Video size: 1024×480) 

                 

Advantages: It will not lose any picture, and the quality will also not be reduced.  

Disadvantages: The picture is distorted or stretched. 
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7 Setting profile 

7.1 Supported profile 
 

Default parameters for the profiles 
Profile 

Video Audio 
Remark 

3GPP 
3GP P– 3rd Generation Partnership 

Project (*.3gp) 
Codec:mpeg4 

Video size:176×144 

Bit rate:120 

Codec: amr_nb 

Bit rate: 48 

3GPP 2– 3rd Generation Partnership 

Project 2(*.3g2) 
Codec:mpeg4 

Video size:176×144 

Bit rate:120 

Codec: mpeg4aac 

Bit rate: 48 

Suitable for portable devices 
such as 3G mobile phones. 
Please make your choices 
as per different devices. 

Apple TV 
Apple TV h264(320*240) (*.mp4) Codec: h264 

Video size: 320×240 

Bit rate: 1200 

Codec: mpeg4aac 

Bit rate: 64 

 
Apple TV h264 480P(640*480) (*.mp4) Codec: h264 

Video size: 640×480 

Bit rate: 2000 

Codec: mpeg4aac 

Bit rate: 64 

 
Apple TV h264 720P(1280*720) (*.mp4) Codec: h264 

Video size: 1280×720 

Bit rate: 2500 

Codec: mpeg4aac 

Bit rate: 64 

 
Apple TV MPEG-4 high 480P(640*480) 

(*.mp4) 
Codec: mpeg4 

Video size: 640×480 

Bit rate: 1500 

Codec: mpeg4aac 

Bit rate: 128 

 
Apple TV MPEG-4 Low 480P(640*480) 

(*.mp4) 
Codec: mpeg4 

Video size: 640×480 

Bit rate: 800 

Codec: mpeg4aac 

Bit rate: 64 

 
Apple TV MPEG-4 Normal 480P(640*480) 

(*.mp4) 
Codec: mpeg4 

Video size: 640×480 

Bit rate: 1200 

Codec: mpeg4aac 

Bit rate: 96 

 

Suitable for playing videos on 

Apple TV. 

Please make your choice 

according to the devices. 

iPod
iPod (320x240) MPEG-4 Normal (*.mp4) Codec:mpeg4 

Video size:320×240 

Bit rate:1200 

Codec: mpeg4aac 

Bit rate:64 

iPod Video2 (640x480) MPEG-4 Normal 

(*.mp4) 
Codec:mpeg4 

Video size:640×480 

Bit rate:1200 

Codec: mpeg4aac 

Bit rate:80 

Suitable for iPod. 

 

MPEG1/MPEG2
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MPEG-1 Movie (*.mpg) Codec:mpeg1video 

Video size:320×240 

Bit rate:1600 

Codec:mp2 

Bit rate:192 

MPEG-2 Movie (*.mpg) Codec:mpeg2video 

Video size:320×240 

Bit rate:2000 

Codec:mp2 

Bit rate:192 

Video CD (*.mpg) Codec:mpeg1video 

Standard: NTSC 

Video size:352×240 

Bit rate:1150 

Codec:mp2 

Bit rate:224 

VOB-MPEG2 PS Format (*.vob) Codec:mpeg2video 

Standard: NTSC 

Bit rate:6000 

Codec:ac3 

Bit rate:448 

Super VideoCD (*.mpg) Codec:mpeg2video 

Standard: NTSC 

Video size: 480×480 

Bit rate: 2040 

Codec: mp2 

Bit rate: 224 

 

DVD (*.vob) Codec: mpeg2video 

Standard: NTSC 

Video size: 720×480 

Bit rate: 6000 

Codec: ac3 

Bit rate: 448 

 

Zune 
Zune MPeG-4 AVC Video Format (*.mp4) Codec:h264 

Video size:320×240 

Bit rate:1500 

Codec: mpeg4aac 

Bit rate:64 

Zune MPEG-4 Video (*.mp4) Codec: mpeg4 

Video size: 320×240 

Bit rate: 1500 

Codec: mpeg4aac 

Bit rate: 128 

Zune WMV-Windows Media Video 

(*.wmv) 
Codec: wmv3x 

Video size:320×240 

Bit rate:1500 

Codec:wma7x 

Bit rate:128 

 

PS3 Video
PS3 Video (1080P) MPEG-4 (*.mp4); Codec: h264 

Video size:1920×1072 

Bit rate: 2000 

Codec:mpeg4aac 

Bit rate: 256 

PS3 Video (720P) MPEG-4 (*.mp4); Codec:h264 

Video size: 1280×720 

Bit rate: 2000 

Codec:mpeg4aac 

Bit rate:256 

PS3 Video (480P) MPEG-4 (*.mp4) Codec:h264 

Video size:720×480 

Bit rate:1200 

Codec:mpeg4aac 

Bit rate:80 

PS3 Video(480P) MPEG-4 

Excellent(*.mp4) 
Codec:h264 

Video size:720×480 

Codec:mpeg4aac 

Bit rate:256 

Suitable for playing video on 
TV connected with PS3
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Bit rate:2500 
PSP
PSP AVC Video Format(*.mp4) Codec:h264 

Video size:368×208 

Bit rate:400 

Codec:mpeg4aac 

Bit rate:64 

 
PSP AVC Video (480x272) (*.mp4) Codec: h264 

Video size: 480x272 

Bit rate: 512  

Codec: mpeg4aac 

Bit rate: 64 

PSP - PSP MPEG-4 Video (*.mp4) Video size:368×208 

Bit rate:512 

Bit rate:64 

Suitable for PSP. 

MPEG-4 
MOV - QuickTime (*.mov) Codec: mpeg4_qt 

Bit rate: 768 
Codec: mpeg4aac_qt

Bit rate: 128 
AVI - Audio-Video Interleaved (*.avi) Codec: mpeg4 

Bit rate: 1200 
Codec: pcm_s16be 

ASF - Advanced Streaming Format (*.asf) Codec: msmpeg4 

Bit rate: 1200 
Codec: mp3 

Bit rate: 128 
DivX Movie (*.avi) Codec: mpeg4 

Bit rate: 1200 
Codec: mp3 

Bit rate: 128 
MPEG-4 AVC Video Format (*.mp4) Codec:h264 

Video size:320×240 

Bit rate:768 

Codec: mpeg4aac 

Bit rate:128 

MP4 - MPEG-4 Video (*.mp4) Codec: mpeg4 

Bit rate:1200 

Codec: mpeg4aac 

Bit rate:64 

RM - RealVideo (*.rm) Codec:rv10 

Video size:320×240 

Bit rate:384 

Codec: ac3 

Bit rate: 128 

 
WMV - Windows Media Video (*.wmv) Codec: wmv3x 

Video size:320×240 

Bit rate:1200 

Codec:wma7x 

Bit rate:128 

XviD Movie (*.avi) Codec: XviD  

Bit rate:1200 
Codec:mp3 

Bit rate:128 
FLV - Flash Video Format (*.flv)  Codec: mp3 

Bit rate: 32 

SWF - SWF Format (*.swf)  Codec: mp3 

Bit rate: 32 

 

 

Audio 
AAC - Advanced Audio Coding (*.aac)  Codec: aac 

Bit rate:128 
AC3 - Dolby Digital AC-3 (*.ac3)  Codec: ac3 

Bit rate: 192 
WAV - Waveform Audio (*.wav)  Codec:pcm_s16le 
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WMA - Windows Media Audio (*.wma)  Codec:wma7x 

Bit rate:128 
OGG - Ogg Vorbis Audio (*.mp4)  Codec: Vorbis 

Bit rate: 160 
MP2 - MPEG Layer-2 Audio (*.mp2)  Codec: mp2 

Bit rate:224 
MP3 - MPEG Layer-3 Audio (*.mp3)  Codec: mp3 

Bit rate:192 
M4A - MPEG-4 Audio (*.m4a)  Codec: mpeg4aac 

Bit rate:128 
RA - RealAudio (*.ra)  Codec: ac3 

Bit rate: 128 
SUN AU Format (*.au)  Codec: pcm_s16be 
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7.2 Common output property list 
Parameters Remarks 
General Set general encoding properties, including the duration, start time and the output filename.

Duration 

Set the encoding duration. 

The default is "full", which means the full duration of the source file. 

If you wish to convert a clip of the file, please set the duration for the clip. 

For example, if you wish to convert the clip from 00:00:50 to 00:02:50 please set the duration 

to: 120s. 

Start time 

Set a start time for the encoding. 

The default value is "00:00:00", which means that the conversion starts at the beginning of 

the source file. 

If you wish to convert a clip of the file, please set the duration for the portion. 

For example, if you wish to convert program from 00:00:50 to 00:02:50, please set the start 

time to: 00:00:50. 

Video Set video parameters for the output files. 

Video codec 

Set video codec. 

Generally, please keep the default settings. 

For some exceptional profiles, we provide various encoding codecs. Please 
make your choices as per your needs.  

Standard 

Set the video standard (PAL, NTSC) for MPEG or VOB formats. 
Please ensure that it should be the same with the source file. 
For example, if the source is in "PAL", please set it to "PAL". 

Video Size 
Set the video size (W×H). 
It is recommended to select a value not more than that of the source file. 

Bit rate 

Set video bit rate (Unit: kbit/s). 

There is a default video bit rate in the profile. 

It can be modified according to the video bit rate of the source file. 

For example: If the higher quality is required, then a larger bit rate should be selected. The 

size of the output file will become larger accordingly. 

Maximum Bit Rate 

Minimum Bit Rate 

Set the peak bit rate for the output file(Unit: kbit/s). 
By setting the two values, the better output quality can be achieved. 
Tip: Max. Bit Rate≥ Bit Rate(the default)≥Min. Bit Rate 

Buffer Size 
Set buffer size (Unit: kByte). 
Generally, please keep the default value. 

Frame Rate 
Set the Frame Rate (Hz value, fraction or abbreviation). 
Generally, please keep the default value. 

Aspect ratio Set the aspect ratio for playing back the outputs (4:3, 16:9 or 1.3333, 1.7777). 
Bitrate Tolerance Set the output bit rate tolerance, i.e. the deviation from the bitrate set. 
Same quality Set to True and the output files will have the same quality as the source one. 
Disable Video Set to True and the video stream will not be available in the outputs. 
Audio  
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Audio codec 

Set the audio codec.  

Generally, please keep the default settings. 

For certain exceptional profiles, we provide various encoding codecs. Please 
make your choice as per your needs.  

Bit rate 

Set the audio bit rate (Unit: kbit/s). 

There is a default audio bit rate in the profile. 

It can be modified according to the audio bit rate of the source file. 

For example: If higher quality is required, then larger bit rate should be selected. The size of 

the output file will become larger accordingly. 
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8 Technical Support 

8.1 FAQ 

Q: Is ID3v2 supported? 

A: Yes. 

With ImTOO MPEG Encoder, if you have selected profiles of WMV, WMA and MP3, then you can 
edit ID3 tags (including ID3v1 and ID3v2) for output files in the output property list on the right side 
of the main interface. 

For more information about "ID3", please refer to the chapter "Common Output property list" in 
"Set Profile".  

Tip: The ID3 tag information is the relevant information contained in an MP3 audio file, including 
the titles, singers, album names, years, genre and comments of the songs etc.. 

The ID3 tag information has two versions, v1 and v2. The ID3 tag of V1is 128 bytes at the end of 
an mp3 audio file, and starts with three characters of TAG. The ID3 tag of V2 is at the beginning of 
an mp3 audio file, which can also contain much more information such as lyrics and album 
images. 

 

Q: How to change language? 

A: On the “View” menu, click “Language”, and then in the Language list, click the language that 
you want to apply. 
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After the selection, all commands, functions and items in the software will be displayed in the 
selected language.  

 

Q: How to view the conversion log? 

A: The software supports the log view. You can easily view the conversion log during or after the 
conversion. 

To do this: 

Step1: After the conversion, select the file you wish to view in the video list; 

Step2: Click the  button at the right bottom of the status bar to open the Log box. In the box, 

you can find the detailed information about the conversion, as well as errors that could be 
encountered during the conversion. 

Here is an example: 
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Q: How to set the simultaneous conversion process? 

A: On the “Tools” menu, click the ”Preferences“ to open the Preferences tab. In the General tab, 
you can set the Maximum simultaneous processes and Maximum simultaneous running 
processes. 

Here it shows: 

 

The default value: Maximum simultaneous processes = 10; Maximum simultaneous running 
processes = 2. 

After the setting, please click "Apply" to activate your setting. Your setting will be effective in the 

 



 

following conversion. 

with the default settings, when you click "Encoding" button, all files in the video list will enter into 
"Waiting" status, in which 2 files will start to be converted simultaneously. During the conversion, 
you can have pauses for the conversion being done. Generally, the total files which are "under 
conversion" and "under pause" could be 10 at most. 

Tips:  

1. For the function of Maximum simultaneous processes and maximum simultaneous running 
processes, the multi-threading technology is utilized so as to improve the conversion efficiency of 
software. 

2. The value you set should not be too large. Otherwise, it will spend more time in the process 
scheduling; the conversion may be not stable instead of high efficiency. It is noted that the 
maximum simultaneous running processes are required to be less than or equal to the maximum 
simultaneous processes. 

For more information about "process", please refer to the chapter "Preferences tab>General" in 
"Operation Instructions". 

 

Q: How to set zooming modes and splitting modes for the output videos? 

A: The software has "Zoom" and "Split" options on the output control panel of the main interface. 
Using these two options, you can select the required zooming modes and splitting modes. 

To do this: 

Step1: Select the file you wish to convert in the video list; 

Step2: On the output control panel, click to open the "Zoom" drop list, and select the required 
zooming mode; likewise, click to open the "Split" drop list to select the required splitting mode. 

After the conversion, you will get the file that you want. 

For more information about "File zooming modes" and "File splitting modes", please refer to the 
chapter "Output control panel" in "Operation instructions" and the chapter "Movie Zoom Rule" in 
"Advanced Operation". 

 

Q: How to view file information? 

A: Select the file in the video list and right click to open the right-click menu. Click "Show file 
information" to open "File Information" box to view the related file information. 
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In addition, “View > Show File Information“ is also for you to view the file information. 

 

8.2 Contact us 

If you meet any problems when using the software, please contact us for technical support by the 
following method. 

Send an email to support@imtoo.com. Our customer service staff will give you a response within 
one (1) working day. 

We would appreciate it if you could attach your conversion log along with your email. It would help 
us for a quick trouble-shooting. 

For more information about the "Conversion Log", please refer to the chapter "FAQ>How to view 
conversion log" in "Technical Support". 
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9 Buying ImTOO MPEG Encoder 

9.1 Buy a registration code 

On the “Help” menu, Click the “Buy Registration Code“ option to log on ImTOO MPEG Encoder’s 
website for the online purchase. 

 

 

9.2 Registration 

After the purchasing, you will receive the registration code through email. Run ImTOO MPEG 
Encoder, in the main interface, click the “Enter Registration Code“ option in the "Help“ drop-down 
menu to open the “Registration” dialogue box. 

 

Enter the user’s "Name" and "License Code" and click “OK“ to finish the registration and close the 
dialogue box. 
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If you click “Later“, you will experience the trial version. 

Tip: With the trial version, you can only convert 5 minutes of a single file; if the duration of this file 
is less than 5 minutes, you can only convert half of it. 

In addition, the setting of "Start Time" and "Duration" will also be not available. 
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10 Annex 

10.1  Introduction to ImTOO 

ImTOO Software Studio is a professional provider for multimedia software applications and the 
related information to the international users. Since founded in Year 2003, it has been playing a 
more and more important role in this area. At present, there are various professional DVD, video 
and audio tools which are highly reputed and recommended by numerous users for the easy-use, 
fast-speed and powerful-function.  

Based on the same pursuance of providing excellent integration software and ersonal application 
to meet the different needs from numerous multimedia fans, ImTOO Software Studio and Xilisoft 
Corporation work together as cooperating partners with shared resource and independent identity. 
Each of them owns the copyright to the products under the corresponding brand.  

 

At present, there are 47 products from ImTOO on the market. All products are released after 
intense research. 

ImTOO MPEG Encoder

A fast, extremely easy to use AVI MPEG converter, MPEG4 WMV converter, video and audio 
software, converts between all popular video and audio formats easily, quickly with high quality. 

ImTOO DVD Ripper Platinum

An powerful, easy to use DVD ripping software, helps you to rip DVD movie to all video/audio 
formats with great DVD rip quality with multi-options.  

ImTOO DVD Creator

An easy and fast DVD creating software, helps you to convert video files to DVD and burn DVD 
movie playable on portable or home DVD player. 

ImTOO DVD Copy Express

An extremely easy-to-use DVD copying software, provides the best way to copy DVD movie with 
excellent DVD copying quality 

ImTOO Audio Maker
A multifunctional music converter, MP3 CD burner and audio CD burning software, converts, rips, 
and burns music CD easily, fast, with excellent quality.  

 

Further assistance: 
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• If you met problems about registration code or issues on being successfully registered: Please 
visit our order lookup page http://www.imtoo.net/orderlookup.php to retrieve it by yourself 
immediately or contact our market department at sales@imtoo.com.  

• If you met problems about usage of this software or other issues: Please visit 
http://www.imtoo.com/support.html to find the solution there by yourself or contact our support 
team at support@imtoo.com  

 

Any success comes with the support from the users and customers. To show our thanks, ImTOO 
Software Studio will work harder to aim at providing first-rate software and excellent service in the 
following days to meet your needs. 
 

10.2  Introduction to ImTOO software 

10.2.1 ImTOO iPod Movie Converter 

ImTOO iPod Movie Converter is a powerful iPod video converter software.  

With versatile functions and various settings, it can convert most popular video and audio files like 
AVI, MPEG, WMV, MOV, MP4, RM, RMVB, H.264, VOB, DivX to iPod video MP4 and iPod audio 
such as MP3, AAC and M4A for Video iPod, Video iPod 30GB/80GB, iPhone mobile and Apple TV 
perfectly. 

Besides the above powerful function, it provides versatile settings and features as well. You can 
convert audio/video clips with customized starting point and length, choose the destination of the 
output file, set the zooming mode and splitting mode for the output file, and rename the output file, 
etc. 

For full information about ImTOO iPod Movie Converter, please visit: 

http://www.imtoo.com/ipod-movie-converter.html  

http://www.imtoo.com/support.html

 

10.2.2  ImTOO MP4 Video Converter 

ImTOO MP4 Video Converter is a powerful and easy to use MP4 video converter Software.  

It can convert most popular video and audio formats, such as AVI, MPEG, DivX, MOV, RM, WMV, 
MP4, 3GP, VOB, VCD, DV, H.264/MPEG-4 AVC, H.264/PSP AVC, to MP4 video and audio formats 
directly like MP4 ,M4A, AAC, and MP3, which can be played in your iPod, iPhone and Apple TV. 
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Besides the above powerful function, it provides versatile settings and features as well. You can 
convert audio/video clips with customized starting point and length, choose the destination of the 
output file, set the zooming mode and splitting mode for the output file, and rename the output file, 
etc. 

For full information about ImTOO MP4 Video Converter, please visit: 、 

http://www.imtoo.com/mp4-video-converter.html  

http://www.imtoo.com/support.html  

 
 
10.2.3  ImTOO 3GP Video Converter  

ImTOO 3GP Video converter is powerful 3GP converter software for all mobile phone users, which 
supports all mobile phone video formats including 3GP (3GPP), 3G2 (3GPP2) and MPEG-4 
(.mp4).  

It can convert most popular video formats like MPEG1/2/4, WMV, MP4, MOV, RM, DV, YUV, 
H.264/MPEG-4 AVC to 3GP, MPEG-4 video files. Meanwhile, the software could also convert 3GP 
video to popular video file formats such as AVI, MPEG and DivX which can be played on your 3GP 
mobile phone at any time. 

Besides the above powerful function, it provides versatile settings and features as well. You can 
convert audio/video clips with customized starting point and length, choose the destination of the 
output file, set the zooming mode and splitting mode for the output file, and rename the output file, 
etc. 

For full information about ImTOO 3GP Video Converter, please visit: 

http://www.imtoo.com/3gp-video-converter.html  

http://www.imtoo.com/support.html

 

10.2.4 ImTOO Apple TV Video Converter 

ImTOO Apple TV Video Converter is a powerful video and audio conversion program for your 
Apple TV.  

It can convert most popular video and audio formats, such as AVI, MPEG, WMV, MOV, MP4, VOB, 
DivX, XviD, AAC, WMA, WAV, AC3, MP3 to the video and audio formats that the Apple TV 
supports, including MPEG-4, MP3, AAC, WAV, etc. 
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Besides the above powerful function, it provides versatile settings and features as well. You can 
convert audio/video clips with customized starting point and length, choose the destination of the 
output file, set the zooming mode and splitting mode for the output file, and rename the output file, 
etc. 

The software is easy to handle. What you only need to do is choosing the files you want to convert, 
setting up the formats and parameters for the output files and then clicking the "Encode" button to 
begin the conversion. 

For full information about ImTOO Apple TV Video Converter, please visit:  

http://www.imtoo.com/appletv-video-converter.html  

http://www.imtoo.com/support.html

 

10.3  List of ImTOO websites 

Website:http://www.imtoo.com 
Product: http://www.imtoo.com/discount-packs.html 
Free Downloads: http://www.imtoo.com/download.html 
Help: http://www.imtoo.com/general-question.html 
Support, Guide, Tips, FAQs: http://www.imtoo.com/support.html 
Contact: http://www.imtoo.com/contact.html
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